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Trademark Information

Apple, the Apple logo, Macintosh, and Quick Time are registered
trademarks of Apple Computer, Inc.
Adobe and Adobe Photoshop are trademarks of Adobe Systems
Incorporated.
All other brand or product names mentioned in this manual are the
trademarks or registered trademarks of their respective holders.

Cautions

• The reproduction of all or part of this manual without our permission is
prohibited.

• The information contained in this manual is subject to change without
notice.

• We have made every effort to produce a perfect manual, but should you
find any mistakes, we would be grateful if you would kindly let us
know.

• We shall take no responsibility for consequences resulting from the
operation of this product, despite the terms mentioned above.

Warning!

The CD-ROM on which this software is distributed should not be played
back on audio CD equipment.  Playing CD-ROMs on an audio CD player
could cause hearing loss or damage the equipment.
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Notice concerning prohibition of copying or reproduc-
tion

Note that simply being in possession of material which has been copied or
reproduced by means of a digital camera may be punishable by law.

Items prohibited by law from being copied or reproduced

Do not copy or reproduce paper money, coins, securities, government
bonds, or local government bonds, even if such copies or reproductions are
stamped “Sample.”

The copying or reproduction of paper money, coins, or securities which are
circulated in a foreign country is prohibited.

The copying or reproduction of unused postage stamps or post cards issued
by the government without obtaining approval from the government is
prohibited.

The copying or reproduction of stamps issued by the government and
certified documents stipulated by law is prohibited.

Cautions on certain copies and reproductions

The government has issued cautions on copies or reproductions of
securities issued by private companies (shares, bills, checks, gift
certificates, etc.), commuter passes, or coupon tickets, except when a
minimum of necessary copies are to be provided for business use by a
company. Also, do not copy or reproduce passports issued by the
government, licenses issued by public agencies and private groups, ID
cards, and tickets, such as passes and meal coupons.

Comply with copyright notices

The copying or reproduction of works such as books, music, paintings,
woodcut prints, maps, drawings, movies, and photographs which are
copyrighted creative works is prohibited except when it is done for
personal use at home or for similar restricted and non-commercial use.
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1Overview

Overview

Welcome to Nikon View Macintosh, a companion program for the
COOLPIX 300. Nikon View offers a combination of browser, simple
editing, and file-transfer capabilities. Using these three functions, you can
play back images and audio data from your camera’s memory, edit them in
Nikon View or any other application which supports Photoshop-compatible
acquire plug-ins, and save them to your computer for use in other
applications or for long-term storage. Once you have installed Nikon View
and mastered its simple tool buttons and menus, you’ll be able to distribute
your digital photographs by disk or electronic mail, or include them in your
home page and other documents you create for business or personal use.

Nikon View’s features include:

• a browser function which allows you to preview at a glance all the
images and recordings stored in your camera’s memory, and to select
items for editing, transfer to disk, or deletion

• compatibility with Adobe Photoshop version 2.0 plug-in specifications,
making it possible to launch the browser from any application which
supports acquire plug-ins compatible with this standard

• support of drag-and-drop, allowing rapid transfer of photographs,
memos, and audio data to your computer or to other applications

• playback of audio data using either the camera’s built-in speaker or
your computer’s audio system, and the capacity to save audio
recordings as System 7 sound files

• simple editing of image data using Nikon View’s one-touch tool palettes
and menus

• support of TIFF, JPEG and PICT image formats, giving you added
flexibility when using images created with your COOLPIX 300 in other
applications or when distributing photographs by diskette or electronic
mail
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This manual will guide you, step-by-step, through the process of setting up
and using Nikon View with your COOLPIX 300. The next section, “Before
You Begin,” gives details of how to install Nikon View on your Macintosh.
It is followed by “Getting Started,” which introduces you to the basics of
using Nikon View to preview the contents of your camera’s memory, select
items for editing or playback, and save images and recordings to disk.
Refer to “Using the Browser” and “Working with Documents” for detailed
information on using Nikon View’s browsing and editing functions.
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Before You Begin

This section gives the system requirements for Nikon View Macintosh and
guides you through the process of installing Nikon View to your computer’s
hard disk.

System Requirements

To run Nikon View Macintosh, you will need system hardware and
software which meet the following minimum requirements:

• a Power Macintosh, or a Macintosh with a 68030 or better CPU

• System Software 7.1 or later

• at least 8 MB of free RAM (12 MB or more is recommended)

• 5 MBs of free space on your hard-disk for installation, with an
additional 20 MBs of free space when Nikon View is running

• a monitor with a resolution of 640 × 400 dots or higher capable of
displaying 16.7 million colors

• a CD-ROM drive

•  a serial or SCSI port for connection to the COOLPIX 300 (note that the
optional SCSI Kit is required for connection to a SCSI port)
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Installation

The installation disk provided with this product contains Nikon View’s
editor and the browser plug-in which handles the exchange of information
between your Macintosh and the COOLPIX 300. Before starting the
installation program, check to be sure that you have enough space on your
hard disk to complete installation (a minimum of 25 MBs of free disk
space is required), and that no other applications are running.

Step 1 — Launch the Nikon View installer

Insert the installation disk in the drive and double-click the installer’s icon.

The following dialog box will appear.
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Step 2 — View the README file

Clicking Continue…  will cause the dialog box shown above to be
replaced by the Nikon View README file.  It is recommended that you
take a view moments to print or view the contents of this file, as it may
contain important information that could not be included in this manual.
When you have finished, click the Continue  button to bring up the
Installer dialog shown below.

You can return to the README file by clicking the Read Me… button at
the top right corner of the Installer dialog.  When installation is complete, a
copy of the README file will be saved in the directory to which you have
installed Nikon View.
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Step 3 — Select a destination folder

Use the Switch Disk  button in the Installer dialog to choose the disk to
which you will install Nikon View and the Nikon View browser plug-in (the
drivers for your COOLPIX 300 will be installed to the Preferences folder
in the System folder).  To select a folder for installation, click the Select
Folder  button.  This will bring up the dialog box shown below.

Specify the folder to which you would like to install the software and then
click Select .  This will return you to the Installer dialog.



7Before You Begin : Installation

Step 4 — Install Nikon View

Clicking the Install  button in the Installer dialog starts the installation
process.  While the program’s components are being installed to the
selected directory, the following progress indicator will be displayed.

Clicking Stop  will bring up the message shown below.

Click Resume  to continue the installation from the point it was
interrupted.  Clicking Stop  will halt the installation without installing
Nikon View.  Should you choose to abandon the installation, you can still
install Nikon View at a later date by repeating the installation process from
Step 1 .
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Step 5 — Check the memory available to Nikon View

When installation is complete, the following dialog box will be displayed.

Click Quit  to exit the installer.  Once you have returned to the Finder,
locate the Nikon View folder in the directory you chose in Step 3 .   Open
the folder and click the Nikon View icon once to select it.

Nikon View icon

Then choose Get Info ( I) from the File  menu in the Finder.
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If possible, in the “Preferred size” text box enter a value equal to or greater
than the suggested size value.



10 Before You Begin : Installation

Step 6 — Copy the Nikon View plug-in into the plug-ins folder
(optional)

If you will be using Nikon View’s browser with another application that
supports Adobe Photoshop plug-ins, you will need to copy the Nikon View
acquire plug-in into the application’s plug-ins folder.  In the directory to
which you installed Nikon View, click the plug-in’s icon once to select it.

Then, holding down the option  key on the keyboard, drag the icon into the
desired plug-in folder.  Repeat this task for each of the applications you
plan to use when acquiring documents from your COOLPIX 300.
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Getting Started

Once you have installed the Nikon View software as described in “Before
You Begin,” you are ready to use your computer to view the contents of
your COOLPIX 300’s memory or to transfer images and recordings to your
computer for editing and storage. This chapter provides a brief
introduction to Nikon View’s menus and buttons, and outlines the steps you
will take when using the program with your COOLPIX 300. More detailed
information may be found in the following chapters, “Using the Browser”
and “Working with Documents.”

First Steps

This section guides you step-by-step through the basics of using Nikon
View to acquire documents (images and audio recordings) from your
camera, modify them, and save them to disk. An overview of the
program’s menus and tool palettes may be found in the following section,
“A Closer Look at Nikon View.” More detailed information on using Nikon
View to browse the contents of your camera’s memory or play back images
and sound recordings can be found in the following chapters, “Using the
Browser” and “Working with Documents.”

Step 1 — Connect the COOLPIX 300 to Your Computer

After making sure that both your camera and computer are off, connect the
devices as described in the COOLPIX 300 User’s Manual. Turn on the
camera and any other peripheral devices, then turn on your Macintosh.
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Step 2 — Start Nikon View

Start Nikon View by double-clicking the program’s icon.

Nikon View’s main tool palette will appear on the desktop and the File ,
Edit , Tools , and Window  menus will appear in the menu bar.

The first time you start Nikon View after installing the program or changing
the port used to connect your camera to the computer, the following
message will be displayed.



13Getting Started : First Steps

If you have connected your camera to the computer’s SCSI chain, click
OK and proceed to Step 3 . Clicking No will bring up the message shown
below.

If you have connected your camera to the modem port, click OK and
proceed to Step 3 . If you have connected your camera to the printer port,
click No.  When the message shown below appears, click OK to select the
printer port as the port used by the camera.
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Step 3 — Acquire Documents from the Browser

Once Nikon View has located the camera, the browser window will appear
on the desktop.
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Acquire an Image

The browser shows a list of documents, which may each contain a single
image or recording or a combination of photographs, recordings or memos.
You can select a document for acquisition from the browser by clicking its
name, or select multiple documents by holding down the command key
while clicking each additional document in turn, or by dragging the mouse
to select a group of documents. When you have chosen the documents you
want, click the Acquire an Image button in the browser window tool
palette.

The selected documents will be opened in individual document windows,
where they can be flipped or rotated using the buttons on the main tool
palette or document window tool bar. You can also zoom in on an image
by clicking it or zoom the image out by clicking it while holding the
option  key down on the keyboard (when the mouse pointer is over an
image, the cursor will change to the shape of a magnifying glass).
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Step 4 — Save the Documents to Disk

When you have finished playing back and editing a document, you can
select Save As…  from the File  menu to save it to disk.

The following dialog will appear.

After specifying the file type, name, and folder for the recording, click
Save. The image will be saved in the specified location.
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Step 5 — Quit Nikon View

To end your current session of Nikon View, select Quit ( Q) from the
File  menu or click the “Quit Application” button in the main window tool
palette.

Quit Application
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A Closer Look at Nikon View

This section introduces you to Nikon View’s main windows and briefly
describes the program’s menus and buttons.Nikon View’s functions are
shared between two types of window: the browser window, which acts as
an interface between the COOLPIX 300 and your computer, and
document windows, where images and sounds acquired from your camera
can be played back and edited. Most of the operations that can be
performed on acquired images are available from the menus in the menu
bar when Nikon View is the active application.  In addition, buttons on the
main tool palette allow you to perform such tasks as opening the browser
window and rotating and flipping selected images in the browser and
document windows.  The functions of Nikon View’s menus and buttons are
outlined below.
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Menu bar

Main tool
palette

Browser
window

Document window
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The Menu Bar

The menus in the menu bar allow you to manage documents (images and
sounds) that have been acquired from the COOLPIX 300 or saved to disk.
The commands available in each menu are outlined below.  A more
complete description of the tasks that may be performed using the menu
commands may be found in the following chapters, “Working with
Documents” and “Using the Browser.”

The File Menu

The commands that can be accessed from the File  menu are listed below.

New ( N)
This command is only available in a dialog which contains a “New
Folder” option, when it allows you to create a new folder using the

N shortcut.

Open… ( O)
Allows you to specify the name of an image or sound file that has
previously been saved to disk and to then open it in a new document
window.
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Close ( W)
Closes the currently active document window.

Save ( S)
Saves the currently active document to disk under its current name.  If
the document has not previously been saved to disk, this command has
the same effect as Save As… .

Save As…
Allows you to save the currently active document to disk under any
name you specify.

Revert
This command is always grayed out and unavailable.

Page Setup…
Brings up a dialog box which allows you change printer settings such
as paper size and orientation.

Print… ( P)
Prints the currently active document.

Quit ( Q)
Ends your current session of Nikon View. You can also terminate the
program by clicking the Quit Application button in the tool palette.
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The Edit Menu

The Cut ( X), Copy ( C), Paste ( V), Clear , and Select All
( A) commands in the Edit  menu are available when you have opened a
dialog containing a text box, such as the Save As or Open dialogs.  These
commands allow you to select text and copy or cut it from one dialog and
paste it to another (the Select All command can also be used to select all
the documents in the browser). You can not use these commands to copy
image or audio data between documents.

The Preferences… command brings up the Preferences dialog box,
which controls browser and camera settings and allows you to specify a
scratch disk for temporary storage of documents acquired from the camera.
The Preferences dialog can also be accessed by clicking the Edit
Preferences button in the main tool palette (see below).

The Undo ( Z) command is always grayed out and unavailable.
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The Tools Menu

The items available in the Tools  menu are explained below.

Rotate Clockwise
If the browser window is active, choosing this menu item will rotate all
selected images in the browser ninety degrees to the right.  If a
document window is active when this item is selected, any images it
contains will be rotated.  This command can also be accessed by
clicking the Rotate Image Clockwise buttons on the main tool palette or
document window tool bar.

Rotate Counter Clockwise
Rotates images in the browser or active document window ninety
degrees to the left.  This command can also be accessed by clicking the
Rotate Image Counterclockwise buttons on the main tool palette or
document window tool bar.

Flip Horizontal
Flips images in the browser or active document window horizontally.
This command can also be accessed by clicking the Flip Horizontal
buttons on the main tool palette or the document window tool bar.

Flip Vertical
Flips images in the browser or active document window vertically. This
command can also be accessed by clicking the Flip Vertical buttons on
the main tool palette or document window tool bar.

Acquire
Imports all currently selected documents from the browser window to
new document windows in Nikon View.
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The Window Menu

The following items are available in the Window  menu.

Stack
When several documents are open at the same time, choosing this
command arranges them in overlapping windows.

Tile
Arranges documents from left to right across the desktop in non-
overlapping windows of equal size.

Tile Vertical
Arranges documents from top to bottom across the desktop in non-
overlapping windows of equal size.

Create/Select Browser
Activates the browser window (see “The Browser Window,” below).
The browser can also be activated by clicking the camera icon in the
main tool palette.

Document List
The names of all documents currently open in Nikon View are displayed
at the end of the Window  menu. The active document is indicated by
a check mark; you can choose another document window as the active
document by selecting it from this list.
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The Main Tool Palette

When Nikon View is running or when the browser has been opened from
another application, the following tool palette will appear on the desktop.

The tool palette can be moved anywhere on the desktop by dragging it by
its title bar. When you restart Nikon View, the palette will reappear in the
position you left it when you last quit the program.
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The function of each of the buttons in the main tool palette is described
briefly below.  The function of a button can also be learned by resting the
mouse pointer on it for a few seconds, which will cause a label to appear
identifying its function.

Select Browser Window
Clicking this button brings up the browser
window. The browser window can also be
opened by choosing Select Browser
from the Window  menu.

Flip Image Horizontally
If the browser window is active, clicking
this button flips all selected images in the
browser horizontally.  When a document
window is active, any images (photographs
or memos) it contains will be flipped. This
command can also be accessed by clicking
the Flip Image Horizontally button in the
document window or by choosing Flip
Horizontal  from the Tools  menu.

Flip Image Vertically
Flips the image in the browser or active
document window vertically. This
command can also be accessed by clicking
the Flip Image Vertically button in the
document window or by choosing Flip
Vertical  from the Tools menu.
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Rotate Image Counter Clockwise
Rotates the image in the browser or active
document window 90˚ to the left. This
command can also be accessed by clicking
the Rotate Image Counter Clockwise button
in the document window or by choosing
Rotate Counter Clockwise  from the
Tools menu.

Rotate Image Clockwise
Rotates the image in the browser or active
document window 90˚ to the right. This
command can also be accessed by clicking
the Rotate Image Clockwise button in the
document window or by choosing
Rotate Clockwise  from the Tools menu.

Quit Application Terminates your current session of Nikon
View. This command can also be accessed
by choosing Quit ( Q) from the File
menu.

Edit Preferences Brings up the preferences dialog box,
allowing you to change the settings for the
camera and browser. This command can
also be accessed by choosing
Preferences…  from the Edit  menu.
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Document Windows

When a document is read from disk or acquired from the camera, it is
displayed in a document window similar to that shown below.

Any number of document windows may be open simultaneously, although
only one of these will be active at a time; the active document may be
distinguished from other documents by its title bar. Operations such as
close, save, flip, and rotation performed using the buttons in the main tool
palette or the commands listed in the menus will affect only the active
document.

Title bar

Tool bar
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The Document Window Tool Bar

Each document window has its own tool bar which can be used to get
information about the document it contains, to flip or rotate images, and to
play back any audio data acquired with the document.  The commands
accessible from the document window tool bar are outlined below. You
can also learn the function of a button by resting the mouse pointer on the
button for a few seconds. A label will pop up listing its function.

Get Image Information
Brings up the Information dialog box for
the document, giving its size, location, and
date of recording.

Play Sound If the document contains a sound recording,
clicking this button will bring up a set of
controls which allow you to play the
recording back or save it to disk.

Flip Image Horizontally
Flips the image in the document window
horizontally. This command can also be
accessed by clicking the Flip Image
Horizontally button in the main window
tool bar or by choosing Flip Horizontal
from the Tools  menu.

Flip Image Vertically
Flips the image in the document window
vertically. This command can also be
accessed by clicking the Flip Image
Vertically button in the main tool palette or
by choosing Flip Vertical  from the Tools
menu.
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Rotate Image Counter Clockwise
Rotates the image in the document window
90˚ to the left. This command can also be
accessed by clicking the Rotate Image
Counter Clockwise button in the main tool
palette or by choosing Rotate Counter
Clockwise  from the Tools menu.

Rotate Image Clockwise
Rotates the image in the document window
90˚ to the right. This command can also be
accessed by clicking the Rotate Image
Clockwise button in the main tool palette or
by choosing Rotate Clockwise  from the
Tools menu.
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The Browser Window

The browser window acts as the link between your COOLPIX 300 and
Nikon View, or between your camera and other applications which support
Photoshop-compatible acquire plug-ins. From the browser window, you
can preview documents stored in your camera’s memory, transfer them to
Nikon View for playback and editing, save them directly to disk without
alteration, and delete images and recordings from the camera’s memory.
Images in the browser window can be viewed flipped or rotated using the
buttons on the main tool palette. The browser window can also be used to
control your camera, allowing you to take photographs or make recordings
while the camera is connected to the computer.

The browser’s functions are divided between the browser window tool
palette and the preview window. The preview window is used to view the
contents of the camera’s memory, the tool palette to control the camera and
acquire, save, and delete documents.

The commands available in the browser window are outlined below. For
more information on using the browser, see “Using the Browser.”

Tool
palette

Preview
window
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The Browser Window Tool Palette

The function of each of the buttons in the browser window tool palette is
given briefly below. You can also learn the function of a button by resting
the mouse pointer on the button for a few seconds, which will cause a label
to pop up identifying it by function. More detailed information on the
browser window tool palette may be found in “Using the Browser.”

Take a Picture Triggers the camera’s shutter, taking a
photograph at the camera’s current settings.
For more information on changing the
camera’s settings before you take a
photograph, see “Using the Browser.”

Acquire an Image This button is available when one or more
documents have been selected in the
preview window. The selected documents
are opened in the main window, where they
may be edited or saved to disk in a new
format.

Delete Selected Image(s)
This button is available when one or more
documents have been selected in the
preview window. Clicking the button
brings up the Delete Items dialog, allowing
you to permanently remove the selected
items from the camera’s memory.

Save Selected Image(s)
When one or more items have been selected
in the preview window, clicking this button
saves the selected items under their current
names exactly as they are stored in the
camera’s memory. Any changes made to
the documents in the main window will not
be saved.
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View Images as Thumbnails
Causes a thumbnail preview of each item in
the camera’s memory to be displayed in the
preview window.

View Images as List
Displays the contents of the camera’s
memory as a simple list, without
thumbnails.

Sort Images by Date
Orders the items in the preview window by
date.

Sort Images by Name
Orders the items in the preview window by
name.

Sort Images in Ascending Order
Sorts the items in the preview window in
ascending order by name or date.

Sort Images in Descending Order
Sorts the items in the preview window in
descending order by name or date.

Battery Level Shows the camera’s current battery level.

The browser window tool palette also lists the total number of documents
currently in the camera’s memory and the number of documents selected.

Number of
documents
selected

Total number
of documents
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The Preview Window

Each document listed in the browser’s preview window has three buttons,
which can be used to determine whether the document contains a recording
or a memo, get information about the document, to play back sound
recordings, and to control how memos are displayed.

The functions of these buttons are briefly described in the following
list. You can also learn the function of a button by resting the mouse
pointer on the button for a few seconds. A label will pop up giving its
function.

Show Information Brings up the Information dialog box for
the document, giving its date of recording,
name, and size.

Play Sound This button will be active only if the
document contains a sound recording.  If
the document contains a sound recording,
clicking this button will cause the recording
to be played back from either the camera’s
built-in speaker or your Macintosh.

Toggle Memo This button will only be active if the
document contains a memo. If the button
contains a pencil as shown at left, the
memo will be overlaid on the photograph
when the document is acquired or
previewed.  Clicking the Toggle Memo
button will cause the pencil icon to be
replaced by a document icon ( ).  When
this icon is displayed, the memo will not be
included when the document is acquired or
played back.
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Using the Browser

The browser is your link between the COOLPIX 300 and your Macintosh.
When the camera and computer are connected, the browser allows you to
use the camera much as you would when operating the camera
independently.  It also makes possible the transfer information from the
COOLPIX 300 to your computer, using Nikon View or any other
application which supports Photoshop-compatible acquire plug-ins. This
chapter details how you can use the browser to perform the following
tasks:

• take photographs while the camera is connected to the computer

• preview the contents of the camera’s memory

• acquire documents from the camera for editing in Nikon View or other
applications

• save the contents of the camera’s memory to disk

• delete documents from the camera’s memory

Also included in this chapter are how to change the camera’s settings from
within the browser and how to set the browser’s preferences. Information
on using Nikon View to edit acquired documents, read files from disk, and
save documents under new names or in different formats is given in the
following chapter.

Note: When the camera is being controlled by the browser, the camera
can only be operated via the browser’s Preferences dialog and the Take a
Picture button in the browser window tool palette (for more information,
see “Preferences” and “ Taking Photographs,” below). The camera’s
touch-panel controls and record and shutter-release buttons will be
deactivated.
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Preferences

Nikon View’s Preferences dialog box allows you to control a number of
settings that affect how the program communicates with your camera. By
changing the preferences, you can control:

• your camera’s flash, image quality, speaker, and recording settings;

• whether documents acquired from your camera remain in the camera’s
memory after acquisition;

• whether the browser window remains open after documents are
acquired;

• whether sound recordings are played back using the camera or your
computer’s sound system;

• how annotated photographs will be displayed; and

• where to store temporary files created by the browser.

Changes made to Nikon View’s preferences are saved automatically for use
in your next session.

To open the Preferences dialog box, choose Preferences…  from the Edit
menu or click the Edit Preferences button in the main window tool palette.

Edit Preferences
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The Preferences dialog box will appear.

The Preferences dialog has three tabs which allow you to change the
settings for the browser, camera, and scratch disk.  Each of these tabs is
taken up in turn below.  When you have finished adjusting the settings,
click OK to put the changes into effect and return to the main window or
Cancel  to discard any changes.



38 Using the Browser : Preferences

The Browser Tab

The browser tab in the Preferences dialog box allows you to control how
the browser behaves when an image is acquired and how memos and sound
recordings will be previewed in the browser window.

The options available in the browser tab are listed below.

Close browser after acquire
When this box is checked, the browser window will close automatically
whenever documents are acquired from the browser and opened in the
main window. If this item is not checked, the browser window will
remain open until you click the browser’s close box.

Delete images after acquire
When this box is checked, documents will be deleted from the camera’s
memory when they are acquired from the browser and opened in
document windows. If this item is not checked, documents acquired
from the browser will remain in the camera’s memory until you erase
them using the camera’s delete function or the Delete Selected Image(s)
button in the browser window.
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Play sound through Camera or Macintosh
These radio buttons allow you to choose whether sound recordings will
be played back using the camera’s speaker or the computer’s sound
system.  By default, sounds will be played back from your Macintosh’s
speakers.

Memo Mixer
This slider bar controls how annotated photographs will be displayed.
When the slider is set to the middle, memos will be displayed directly
on the photograph.  Moving the slider to the right increases the
transparency of the memo until only the photograph will be visible;
moving the slider to the left gradually increases the transparency of the
photograph until only the memo is visible. You can gauge the effects of
the new setting by observing the sample image displayed under the
slider.
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The Camera Tab

Using the camera tab in the Preferences dialog box, it is possible to change
the COOLPIX 300’s settings while the camera is being controlled from the
browser.

The camera tab controls the following camera settings:

Compression Mode  (Image Quality)
Clicking on the arrow to the right of this item
reveals up the pop-up menu shown at right,
allowing you to choose from the image quality settings listed below.
High Compression:  Corresponds to an image-quality setting of
Normal, producing photographs which require relatively little memory
to store.
High Quality:    Corresponds to an image-quality setting of Fine,
producing higher-quality images that require twice as much memory to
store as photographs recorded at High Compression Ratio.
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Flash Mode
This item is associated with the pop-up
menu shown at right, which offers the
following choice of flash settings.
Force Off:  Prevents the flash from
firing even when lighting is inadequate.  Choose this setting when the
camera is being powered by the AC adaptor.
Force On:  Causes the flash to fire whenever the shutter is released.
Auto:  Sets the flash to fire only when lighting is inadequate.
Force On with Red Eye Reduction:  The same as Force On ,
except that the red-eye reduction pre-flash will fire before the main
flash to minimize the so-called, “red-eye effect.”
Auto with Red Eye Reduction:    The same as Auto  but with red-
eye reduction.

Playback Volume  (Speaker Volume)
The pop-up menu associated with this item controls the
level of the camera’s built-in speaker (this item has no
effect on the volume at which recordings will be played
back from your computer’s speakers).
Whisper:      Corresponds to a Speaker Volume setting of 1 (low
volume).
Normal:      Corresponds to a Speaker Volume setting of 2.
Loud:      Corresponds to a Speaker Volume setting of 3 (maximum
volume).

Record Sound When Taking a Picture  (Recording Mode 1)
When this box is checked, the camera’s recording mode will be set to
Mode 1, causing a sound recording of fixed duration to be made each
time the shutter is released.  The resulting recording will be stored in
the camera’s memory as part of the same document as the photograph.
The length of the audio recording can be set entering a value in the
Recording Time text box.
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Use settings dialog when taking pictures
When this item is checked, clicking the Take a Picture button in the
browser window tool palette will cause the following dialog to be
displayed, allowing you to change the camera’s Image Quality, Flash,
and Sound Mode settings before taking a photograph.

If this item is not checked, the above dialog will not be displayed when
the Take a Picture button is pressed.  Instead, a photograph will be
taken using the settings specified in the Preferences dialog box.

For more information on camera settings, refer to the COOLPIX 300
User’s Manual.
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The Scratch Disk Tab

The scratch disk tab in the Preferences dialog box gives you control over
where the browser stores temporary files created when documents are
previewed or acquired. The scratch disk tab lists the disks that can be used
for temporary storage, with a dot next to the disk or disks currently used
for temporary files created by the browser.

By default, the disk used for temporary storage is the disk your Macintosh
uses for Virtual Memory. Disks can be added to or removed from the list of
disks available for temporary storage by first selecting the disks you wish
to add or remove and then clicking the Add/Remove button.  Before any
changes will be put into effect, you will need to exit the Preferences dialog
by clicking OK, quit the current application, and then restart the
application and open the browser window.

Add/
Remove
button
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Opening the Browser Window

If the browser window was open the last time you quit the program, it will
reappear in the same position the next time Nikon View starts up.  If you
are accessing the browser from another application or if the browser
window was not open the last time you quit Nikon View, the browser
window will not be shown at start up. To open the browser window from
Nikon View, choose Create Browser  from the Window  menu or click
the Select Browser Window button in the main tool palette.

To open the browser from another application, choose Nikon View from the
program’s list of acquire plug-ins.

Select Browser
Window
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If the camera is connected to the port to which it was attached the last time
you used the browser, the browser window will be displayed on the desk
top.
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If you have since attached the camera to a different port, the following
message will be displayed when the program attempts to open the browser.

If you have connected your camera to the computer’s SCSI chain, click
OK.  Clicking No will bring up the message shown below.

If you have connected your camera to the modem port, click OK.  If the
camera is connected to the printer port, click No.  When the following
message appears, click OK to identify the printer port as the port used by
the camera.
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If Nikon View is unable to locate the camera, either because the camera and
computer are not properly connected, the camera is off, or you failed to
choose the correct port when prompted, the following message will be
displayed.

Clicking OK will produce a message stating that no camera is connected.
After clicking OK a second time, check to see that the camera and
computer are properly connected and that the camera is on. If the camera is
off or improperly connected, before you will be able to open the browser
you will need to quit Nikon View, turn off the computer, and reconnect the
camera and computer as described in the COOLPIX 300 User’s Manual.  If
you chose the wrong port when prompted by Nikon View, you can click the
Select Browser Window button again and choose the correct port. The
browser will then open normally.  If the port to which the camera is
connected is currently being used by another application, you will need to
close the application before you will be able to open the browser.

Note:  In addition to Nikon View, the browser can be launched from any
application which supports Photoshop-compatible acquire plug-ins (the
browser will appear in the application’s menu of acquire sources as
“Nikon View”).  When the browser is launched from another application,
the browser window and main tool palette will appear on the desk top and
can be operated as described in this chapter.  For information on selecting
and launching acquire plug-ins from within another application, consult
the program’s documentation.
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Previewing Documents

Once you have opened the browser window, you are ready to preview the
contents of the camera’s memory. By default, documents stored in the
camera’s memory are shown in a list which gives the name of each
document and indicates whether the item contains a memo or sound
recording.

To preview photographs or memos, click the View
Images as Thumbnails button in the tool palette. A
progress indicator ( ) will be displayed while the
browser reads the contents of the camera’s memory and
creates preview images (the number to the left of the
indicator shows the number of previews remaining to be created).

View Images as
Thumbnails
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When the browser has finished creating preview images, the memos and
photographs in the preview list will be displayed as thumbnails, while
documents containing only a sound recording will be shown as a square
with an “X” through it (depending on what settings were chosen for
Memo Mixer  in the Preferences dialog, memos or photographs may not
be displayed).

To hide the thumbnails and return to a list-style display,
click the View Images as List button in the browser
window tool palette. View Images

as List
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Each document in the preview list occurs with Information, Play Sound,
and Toggle Memo buttons (   ) . If the document does not contain
a sound recording, the Play Sound button will be dimmed and inactive.
Similarly, if the document does not contain a memo, the Toggle Memo
button will be dimmed.

When a document includes a memo, clicking the Toggle Memo button
( ) will hide the memo’s thumbnail preview, giving you a clearer view of
any photographs that may be underneath and preventing the memo from
being transferred to the document window when the document is acquired.
When the memo is hidden, the Toggle Memo button shows a document
icon ( ).  Clicking the button a second time will reveal the memo once
more.

To preview a sound recording, click the Play Sound button () associated
with the document in question.  If Play Sound Through Camera  has
been selected in the Preferences dialog, the recording will be played over
the camera’s speaker.  If the selected playback mode is Play Sound
Through Macintosh , the Play Sound dialog will appear, allowing you to
play back a selected portions of the recording or to save the entire
recording to disk (see “Playing Back Sound Recordings” in the following
chapter, “Working with Documents”).
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Clicking the Show Information button ( ) for a document in the preview
list will bring up the Information dialog.

Click OK to when you have finished viewing the Information dialog.
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Memos and photographs in the preview window can be flipped and rotated
using the buttons in the main tool palette (for more information on using
the tool palette, see “Working with Documents,” below). To select a
document to be rotated or flipped, click the image in the preview window.
Multiple documents can be selected by holding down the command key
while clicking each of the desired documents in turn.  Any changes to the
document will be preserved when the document is acquired to Nikon View
or another application, but the changes will not be saved until you have
transferred the document to your computer and saved it as described in the
following chapter, “Working with Documents.”

Documents in the browser window can be sorted in ascending or
descending order either by date of recording or by name. To list previews
in order by name, click the Sort Images by Name button in the browser tool
palette. Clicking the Sort Images in Ascending Order button will then
cause the previews to be listed in alphabetical order, while clicking Sort
Images in Descending Order will list the previews in reverse alphabetical
order.  To list previews in order by date, click the Sort Images by Time
button.  Clicking Sort Images in Ascending Order will then list the most
recently created documents last, while clicking Sort Images in Descending
Order will list the most recently created documents first.

Sort Images by Time

Sort Images in
Ascending Order

Sort Images by Name

Sort Images in
Descending Order
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Taking Photographs

The browser window allows you to use your COOLPIX 300 to take
photographs or make audio recordings even when the camera is connected
to your computer. To take a photograph, ready the camera as described in
the COOLPIX 300 User’s Manual.

Note: When making photographs or recordings from the browser, take
care that the camera does not become disconnected — do not attempt to
move the camera to the limit of the cable. Twisting the SCSI cable could
also result in the camera becoming disconnected or even in damage to the
cable itself.

Once you have framed your photograph in the viewfinder, click
the Take a Picture button in the browser tool palette.  If the Use
settings dialog when taking pictures  item in the
Preferences dialog has been checked, the Camera dialog will be
displayed.

Take a
Picture
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The Camera dialog allows you to make changes to the camera’s settings
before taking a picture.  The following settings can be adjusted from this
dialog:

Compression Mode  (Image Quality)
An image quality setting can be chosen from the
options listed in this pop-up menu (shown at
right).  The following settings are available:
High Compression:  Corresponds to an image-quality setting of
Normal, producing photographs which require relatively little memory
to store.
High Quality:  Corresponds to an image-quality setting of Fine,
producing higher-quality images that require twice as much memory to
store as photographs recorded at High Compression Ratio.

Flash Mode
This item is associated with the pop-up
menu shown at right. From this menu,
you can choose one of the flash settings
listed below.
Force Off:  Prevents the flash from firing even when lighting is
inadequate.  Choose this setting when the camera is powered by the AC
adaptor.
Force On:  Causes the flash to fire every time the shutter is released.
Auto:  Sets the flash to fire whenever lighting is inadequate.
Force On with Red Eye Reduction:  The same as Force On ,
except that the red-eye reduction pre-flash will fire before the main
flash to minimize the so-called, “red-eye effect.”
Auto with Red Eye Reduction:  The same as Auto  but with red-
eye reduction.
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Record Sound When Taking a Picture  (Recording Mode 1)
When this box is checked, the recording mode for the photograph you
are about to take will be set to Mode 1, causing a sound recording of
fixed duration to be made whenever the shutter is released. The
resulting recording will be stored in the same document as the
photograph. The length of the recording that will be made when the
shutter is released can be set entering a value in the Recording Time
text box.

Any changes made to the camera’s settings in the Camera dialog are valid
only for the current photograph.  The next time the Take a Picture button in
the browser tool palette is clicked the settings in the Preferences dialog will
have been restored.

Once you have chosen the desired settings, frame your photograph in the
viewfinder and click the Take a Picture  button to record a photograph (if
the Use settings dialog when taking pictures  item in the
Preferences dialog has not been checked, the photograph will be taken as
soon as Take a Picture is chosen from the browser window, using the
camera settings specified in the Preferences dialog box).  While the camera
adjusts its exposure settings and records a picture, the camera’s READY
lamp will blink and a progress indicator () will be displayed in the
browser window.  If Record Sound When Taking a Picture has been
selected, the camera’s recording lamp will also light up when the Take a
Picture  button is clicked and remain on until the recording is finished.

When the camera has finished recording the photograph or combination of
photograph and audio data, the resulting document will be added to the
preview list under a new name.
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Transferring Documents to other Applications

Images viewed in the browser’s preview window can be transferred to the
application you were using when you opened the browser (if the browser
was launched from within Nikon View itself, you will also be able to
acquire sound recordings from the camera).  Once you have acquired a
document from the browser, it can be edited in the calling application or
saved to disk using a new name and format (for information on using
Nikon View to save and edit documents, see “Working with Documents,”
below).  To select a document for transfer, click its name or thumbnail in
the preview window (multiple documents can be selected by holding down
the command key on the keyboard while clicking each of the desired
documents in turn).  If the document contains a memo that you wish to
transfer, be sure that the Toggle Memo button shows a pencil icon (). If
the button shows a document icon (), any memos the document may
contain will not be transferred to the main window when the document is
acquired.

Once all the desired documents have been selected, clicking
the Acquire an Image button in the browser tool palette will
open each of the documents in the application which launched
the browser.

If the Delete images after acquire  box has been checked
in the Preferences dialog box, the selected documents will be removed
from the camera’s memory once they have been transferred from the
browser.  Otherwise the images will remain in the camera’s memory even
after having been copied to the application.  If Close browser after
acquire  has been checked in the preferences dialog box, the browser
window will be closed once the images have been acquired.

Aquire an
Image
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Saving Documents to Disk

The browser window’s save function allows you to save documents to disk
exactly as they are stored in the camera’s memory. To save a document,
select it from the preview window by clicking its title. Multiple documents
can be selected by holding down the command key on the keyboard while
clicking each document in turn.

Once you have selected all the documents you wish to
save, click the Save Selected Image(s) button in the
browser tool palette. The following dialog will appear. Save Selected

Image(s)
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To save the selected documents,  navigate to the desired folder and click
the Select button.  If the Use the following prefix to generate file
names  check box is not checked, images will be saved to disk using the
names under which they are stored in the camera.  Checking this box
allows you to save the documents using the prefix entered in the Prefix
text box.  If the chosen prefix were “Image,” the first of the selected
images would be saved as “Image1.jpeg” (if a file with the same name
already existed in the selected folder, the image would be saved as
“Image1.jpeg.1”), the second image as “Image2.jpeg,” and so forth.
Should you wish to save audio data, be sure that the Save all sounds
next to image files  box is checked.  Audio files will be saved in the
same folder as their associated images, with “.snd” suffixed to the
document name or prefix.

When the Select  button is clicked, the selected documents will be saved to
disk exactly as they are stored in the camera; any flips or rotations applied
to images in the browser will not be saved.  Photographs are saved in JPEG
format at their current compression ratio; audio data are saved as System 7
sound files. Memos cannot be saved from the browser window, but can be
saved from the main window once acquired.

Photographs can also be saved to disk using drag and drop.  Select the
photograph you wish to save by clicking its thumbnail or, when viewing
documents as a list, by its title (multiple images can be selected by holding
down the command key while clicking each of the desired documents in
turn).  Then drag the photographs over the destination folder and release
the mouse button.  The photographs will be saved as JPEG images under
their current names.
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Deleting Documents

The browser can also be used to delete documents from the camera’s
memory. To select a document for deletion, click its title in the preview
window. Multiple documents can be selected by holding down the
command key on the keyboard while clicking each document in turn.

Once you have selected the documents you wish to
delete, click the Delete Selected Image(s) button in the
browser’s tool palette or drag the documents into the
Trash. The Delete Images dialog will be displayed.

Delete Selected
Image(s)

The first document selected will be previewed in the Delete Images dialog.
You can select which elements of the document you wish to delete by
checking the boxes next to Delete Image , Delete Sound , and Delete
Memo . If, for example, the document included a photograph, an audio
recording, and a memo, checking only Image  would delete only the
photograph, while checking both Image  and Memo  would cause both the
photograph and memo to be deleted. Checking all three boxes would result
in the entire document being deleted, while if no boxes were checked
nothing would be deleted.
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Once you have selected which elements you wish to delete, click Delete  to
delete the selected elements from the document previewed in the Delete
Items window. If multiple documents are selected, the next document will
then be previewed in the Delete Items dialog.  Click Cancel  to halt the
operation without deleting further documents.  To delete common elements
from all selected documents at once, click Delete All .  This will cause the
dialog box shown below to appear.

Select the elements you wish to delete and then click the Delete  button.
The chosen element or elements will be removed from all the selected
documents. Note that deleted items are permanently removed from the
camera’s memory; be sure to save documents you want to keep before
deleting them.
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Working with Documents

This chapter describes the operations that can be performed on documents
that have been acquired from the camera and opened in document windows
in Nikon View.

Acquiring Documents from the Camera

To acquire documents from the camera, select the desired documents in the
browser’s preview window.  Once you have selected the documents you
wish to play back or edit, click the Acquire an Image button in the browser
tool palette or select Acquire  from Nikon View’s Tools  menu.

Acquire an Image
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The selected documents will be copied to new document windows in Nikon
View.

Zoom

If the acquired document contains a photograph or memo, you can zoom in
on the image by placing the mouse pointer anywhere within the document
window and clicking. The cursor will take the shape of a magnifying glass
( ) while in the document window. To zoom out, hold down the Option
key on the keyboard and click anywhere in the document window.  While
the Option  key is held down the zoom cursor will contain a minus sign
( ).
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Scrolling and Resizing the Document Window

When the entire image does not fit in the document window, hidden
portions can be viewed by dragging the scroll sliders at the right and
bottom sides of the window, or by clicking the scroll bars or arrow buttons.

Alternatively, the window itself can be enlarged by dragging the resize box
at its lower left corner.

Scroll
slider

Scroll bar

Arrow
button
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If there is enough space on the desktop, the entire document can be viewed
at its current zoom ratio by clicking the fit box () at the top right corner
of the document window.  The document window will be either enlarged to
show the entire image or, if the image is larger than the desktop, enlarged
to fill the desktop.



65Working with Documents : Rotating Images

Rotating Images

Images in a document window can be rotated ninety degrees to the right by
clicking the Rotate Image Clockwise button in the document window tool
bar. The image will be rotated ninety degrees right each time the button is
clicked.

This operation can also be performed on the currently active document by
clicking the Rotate Image Clockwise button in the main tool palette or by
selecting Rotate Clockwise  from the Tools  menu.

Rotate Image
Clockwise

Rotate Image
Clockwise
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To rotate the image ninety degrees to the left, click the Rotate Image
Counter Clockwise button in the document window tool bar. The image
will be rotated ninety degrees to the left each time the button is clicked.

You can also perform this operation on the active document by clicking the
Rotate Image Clockwise button in the main window tool palette or by
selecting Rotate Counter Clockwise  from the Tools  menu.

Rotate Image
Counter Clockwise

Rotate Image
Counter Clockwise
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This operation can also be performed on the active document by clicking
the Flip Image Horizontally button in the main tool palette or by selecting
Flip Horizontal  from the Tools  menu.

Flipping Images

Clicking the Flip Image Horizontally button in the tool bar of a document
window flips any image it may contain horizontally.

Flip  Image
Horizontally

Flip Image
Horizontally
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You can also perform a vertical flip on the active document by clicking the
Flip Image Vertically button in the main window tool palette or by
selecting Flip Vertical  from the Tools  menu.

An image in a document window can be flipped vertically by clicking the
Flip Image Vertically button in the tool bar of the document window.

Flip Image
Vertically

Flip Image
Vertically
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The Play Sound dialog will appear.

Playing Back and Saving Sound Recordings

If a document contains an audio recording, you can play it back by clicking
the Play Sound button on the document window tool bar.

Play Sound
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You can move to any point in the audio clip by dragging the slider.  To
play the recording back, click the Play button ().  Playback can be ended
by clicking the Stop button ( ), or halted temporarily by clicking the
Pause button ( ). Clicking the Rewind button ( ) returns you to the
beginning of the recording, while clicking Fast Forward () takes you to
its end.

While the Play Sound dialog is open, you can save the current recording by
clicking the Save button. This will bring up the following dialog box.

Navigate to the desired location, then enter a name for the recording and
click Save.  The recording will be saved as a System 7 sound file.

When you have finished playing the recording back or saving it to disk,
click the Done  button to close the Play Sound dialog and return to the
document or browser window.
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Getting Information about a Document

Clicking the Get Image Information button in the document window tool
bar will bring up the Information dialog box, which provides details of the
document’s title, size, location, and date and time of recording.

Get Image Information
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The Information dialog box is shown below.

In addition to the document’s title, date and time of recording, and the
amount of space it occupies on disk or in the camera’s memory, the
Information dialog box also gives the document’s dimensions in pixels and
the total amount of RAM or virtual memory used when the document is
open.  When you have finished viewing this document information, click
OK to close the Information dialog.



73Working with Documents : Opening Documents in other Applications

Opening Documents in other Applications

Images in a document window can be transferred directly to other
applications using drag and drop (note that in order to use this technique
the destination application must also support drag and drop).  First, start
the receiving application and open the file in which the image will be
placed.  Arrange the windows so that both the document window and the
destination file are visible and then click the title bar of the document
window to bring it to the front.  Move the pointer over the image in the
document window while holding down the command () key on the
keyboard.  The pointer will change from a magnifying glass to an arrow
cursor.
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Holding down the command key, drag the image from the document
window to the desired location in the destination file, then release the
mouse button.  A copy of the image will be placed in the chosen location in
the destination file.

If the other application does not support drag and drop, documents can be
transferred to other applications by first saving the document and then
opening it in the other application.
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Saving Images

Images in the active document can be saved to disk under a specified name
and file format by selecting Save As…  from the File  menu.

The following dialog box will be displayed.
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The options available in this dialog are explained below.

Eject
If the selected disk is removable, clicking this button will eject it.

Desktop
Returns you to the desktop.

New 
Creates a new folder within the current folder and allows you to specify
a name for it.

File Type
Clicking on the arrow to the right of this item brings up the file type
pop-up menu shown at right.  Images can
be saved in PICT, JPEG, or TIFF formats.

If the selected file type is JPEG, a pop-up menu will appear beneath the
file type menu, allowing you to choose a quality setting for the new
file.  The image quality pop-up menu is shown below.  Image quality
can be chosen from a range of values from Excellent Quality (which
produces the highest quality
images but also requires the
most disk space for storage)
to High Compression
(which produces lower-
quality images requiring less
disk space to store).

Cancel
Returns you to the document window without saving the image.

Save
Saves the image in the current directory and returns you to the
document window.
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To save an image, navigate to the desired location and enter a name for the
file in the text box.  Choose file type and (if applicable) image quality
settings, then click the Save button.

Once a document has been saved to disk using Save As… , any further
changes can be saved to the same file by selecting Save from the File
menu.

Images can also be saved as picture clippings using drag and drop.  If the
image is dragged onto the desktop or over a folder while the command key
is held down, it will be saved as a picture clipping file when the mouse
button is released.  Picture clippings can be viewed by double-clicking the
clipping’s icon, or can be registered as desktop patterns by opening the
Desktop Pattern control panel and copying the clipping file into it by drag
and drop.
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Reading Documents from Disk

Documents previously saved to disk can be opened in new document
windows by selecting Open…  from the File  menu.

The following dialog will appear.
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The options available in this dialog are explained below.

Eject
If the selected disk is removable, clicking this button will eject it.

Desktop
Returns you to the desktop.

Cancel
Returns you to the document window without saving the image.

Open
Opens the selected file or folder.

To open a file, navigate to the desired location and select a file.  The
selected item will be opened in a new document window when the Open
button is clicked.  The file formats that can be read by Nikon View are
PICT, JPEG, TIFF, and System 7 sound files.  Picture clipping files cannot
be opened in Nikon View.



80 The About Dialog Box

The About Dialog Box

To view the About dialog box, which gives copyright and version
information for Nikon View, choose About Nikon View…  from the
Apple menu.

The About Nikon View dialog box will appear.

The About dialog can be dismissed by clicking anywhere within the dialog
box.
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preview window in  31, 34
sorting documents in  52

C
Camera dialog box  42, 53–55
“Clear” command  22
“Close browser after acquire” check box

38, 56
“Close” command  21
“Compression Mode” pop-up menu

in Camera dialog box  42, 54
in Preferences dialog box  40

COOLPIX 300
changing settings while connected to

computer  40
connecting to computer  11

“Copy” command  22
“Cut” command  22
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Flip Image Horizontally button
in document window tool bar  29, 67
in main tool palette  26, 67

Flip Image Vertically button
in document window tool bar  30, 68
in main tool palette  26, 68

“Flip Vertical” command  23, 68

G
Get Image Information button  30, 71

I
“Image Quality” pop-up menu  76
Images

flipping  67–68
opening in other applications  73–74
reading from disk  78
rotating  65–66
saving  75–77

Information window  51, 71–72
Installation  4–10

M
Main tool palette.See Tool palette:

main
Memo mixer  39, 49
Menu bar  12–18, 20–24
Modem port  13, 46

N
“New” command  20
Nikon View installer  4–7
Nikon View plug-in  44, 47

Copying to plug-in folder  10
“No camera connected” error  47

O
“Open…” command  20, 78

P
“Page Setup…” command  21
“Paste” command  22
Photographs, taking  53–55

Photoshop-compatible plug-ins
1, 10, 35, 47

Play Sound button
in browser preview window  34, 50
in document window tool bar

30, 69
Play Sound dialog box  69–70
“Play sound through…” radio button

39
Preferences  

36–43, 49, 50, 53, 55,  56
browser tab  38–39
camera tab  40–42
scratch disk tab  43

“Preferences…” command  22, 36
“Print…” command  21
Printer port  13, 46
Program icon  8

Q
Quit Application button  17, 27
“Quit” command  17, 21
Quitting Nikon View  17

R
README file  6
“Record Sound When Taking a

Picture” check box
in Camera dialog box  42, 54
in Preferences dialog box  41, 55

“Rotate Clockwise” command  23, 66
“Rotate Counter Clockwise” command

23, 65
“Rotate Image Clockwise” button

in document window tool bar
29, 66

in main tool palette  27, 66
“Rotate Image Counter Clockwise”

button
in document window tool bar

29, 65
in main tool palette  27, 65
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S
“Save all sounds next to image files”

check box  58
“Save As…” command  16, 21, 75
“Save” command  21, 77
Save Selected Image(s) button  32, 57
SCSI  13, 46
SCSI cable  53
“Select all” command  22
“Select Browser” command  24, 44
Select Browser Window button  26, 44
Show Information button  34, 51
Sort Images by Date button  33, 52
Sort Images by Name button  33, 52
Sort Images in Ascending Order button

33, 52
Sort Images in Descending Order button

33, 52
“Stack” command  24
Starting Nikon View  12–13
System requirements  3

T
Take a Picture button  32, 53
“Tile” command  24
“Tile Vertical” command  24
Toggle Memo button  34, 50, 56
Tool palette

in browser window  15, 31, 32–33
main  15, 25–27

Tools menu  23

U
“Use the following prefix to generate

file names”  58

V
View Images as List button  33, 49
View Images as Thumbnails button

33, 48

W
Windows menu  24–28

Z
Zoom  15, 62
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